Pro 3 OS 1.2. Addendum
Pro 3 OS version 1.2 adds Patch Morphing, a new feature not covered in the main
User’s Guide. Patch Morphing allows you to transition in real time from one program
to another using one of the Pro 3’s controllers (touch slider, mod wheel, etc). This
gives you the ability to “play” the morph in an expressive way.

Updating Your Operating System
The Pro 3’s operating system is updated via MIDI. You will need a DAW, MIDI
utility,or other application capable of opening and sending MIDI System Exclusive (SysEx) messages. MIDI-OX (Windows) and SysEx Librarian (Mac OS) are
shareware MIDI utilities that can reliably be used to update Sequential instruments. You will also need either a USB cable (Type A to Type B connectors, like
a typical USB printer cable) or a MIDI interface to transmit the SysEx file from
your computer to the Pro 3.
UPDATING THE OS FROM WINDOWS USING MIDI-OX
Before starting, close all other audio or MIDI or DAW software, and disconnect
all other MIDI devices. If necessary, download and install MIDI-OX.
http://www.midiox.com/
To prepare the Pro 3 to receive system exclusive messages:

1. Press Global.
2. From the Global menu, select “MIDI Sysex Enable” and set it to “On.”
3. Next, select “MIDI Sysex Cable.”
4. If you’re using USB to update the OS, choose “USB.” If you’re using a
MIDI interface, choose “MIDI.”
5. Press Global again to exit the Global menu.
6. Connect your computer to the Pro 3 using either a USB cable or a MIDI
interface.
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If using USB, the Pro 3 is a Class Compliant USB device. That means it does not
require any additional drivers to be installed to communicate with your computer.
It will appear in MIDI-OX and other MIDI applications as a MIDI port named
“Pro 3.” (Under Windows XP, it will appear as “USB Audio Device.”)
If using a MIDI interface, connect the computer’s MIDI OUT to the Pro 3’s
MIDI IN. Depending on the type of interface, you may also need a MIDI cable.
Most MIDI interfaces or sound cards with built-in MIDI interfaces will work.
However, we have received reports that Digidesign/Avid interfaces and Native
Instruments Maschine may not transmit SysEx correctly for updates. The
M-Audio Uno is an inexpensive, reliable, and widely available MIDI interface
for use when updating our instruments.
IMPORTANT
There are two parts to the OS update — the Core OS and the Panel OS. Do not
attempt to send both of these at the same time or you may “brick” (disable) your
Pro 3. Instead, send the Core OS first, then, once it completes writing to the
synth, restart the Pro 3. Then send the Panel OS, and once it completes writing,
restart again.
To load and update the OS:

1. Run MIDI-OX.
2. From the Options menu, choose “Configure Buffers.”
3. Set the Low Level Output Buffers “Num” and “Size” to 1024.
4. Click OK to close the window and save the settings.
5. From the Options menu, choose “MIDI Devices.”
6. In the lower left quadrant of the window, select the MIDI port to which
the instrument is connected. If connected via USB, choose “Pro 3” (or
“USB Audio Device” under Windows XP). If connected via MIDI, choose
the MIDI interface. The selected MIDI port appears in the Port Mappings
window.
7. Click OK to close the window and save the settings.
8. From the View menu, choose “SysEx.”
9. From the Command Window menu, choose “Load File.” Browse to and
open the Pro 3 OS update file.
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10. From the Command Window menu, choose “Send SysEx.” The Pro 3
shows a numeric progress display indicating the progress of the SysEx file’s
transfer. Follow any directions listed on the Pro 3’w screen before/after the
numeric indicator completes. When the file transfer completes, “Do not
Turn Off!” is displayed as the OS is written to memory. DO NOT power
down while Pro 3 display shows this message.
11. When the installation completes, turn the Pro 3 off, then back on again. You
can verify the installation by pressing Global. The installed OS version
appears at the bottom right of the screen.
IMPORTANT
If the display goes dark when the update is sent to the Pro 3, do not shut down the
Pro 3. The Pro 3 will automatically power off then back on when the OS update
is complete. The update will take longer than the SysEx transmission displayed in
MIDI-OX.
TROUBLESHOOTING
If the numeric progress indicator stops before the file transfer is complete, turn
the Pro 3 off, then on, and try again. If this continues to happen, double the Low
Level Output Buffers “Num” and “Size” values and re-send the SysEx file. If the
numeric progress continues, then you know your settings are moving in the right
direction. If the countdown goes further from zero try reducing the “Num” and
“Size” settings. You can also try doubling or quadrupling the “Size” setting. You
may have to adjust the Low Level Output Buffers settings several times before
finding the right combination.
If “Status Byte Received In Data” is displayed, turn the Pro 3 off, then on.
This error means some other MIDI message the Pro 3 was not expecting was
sent through your MIDI interface. Make sure all other audio or MIDI or DAW
software is closed, and no other MIDI devices are connected. If you continue to
receive this message try restarting your computer and open MIDI-OX as your
only application.
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RESETTING THE GLOBAL PARAMETERS
You must reset the Global parameters of the Pro 3 after you update the OS.
1. Press the Global button.
2. Press Soft Button 4 to choose the Commands tab
3. Use Soft Knob 1 to select Reset Globals, then press the Write button.
4. Press Soft Button 1 to confirm.
5. When finished, press the Global button again to exit the Global menu.
CALIBRATING THE OSCILLATORS AND FILTERS
Please calibrate the oscillators and filters of the Pro 3 after you update the OS.
1. Press the Global button.
2. Press Soft Button 4 to choose the Commands tab
3. Use Soft Knob 1 to select Calibrate VCOs & Filters, then press the Write
button.
4. The synthesizer performs its auto-calibration procedure. Don’t turn off the
power while it’s doing this.
5. When finished, the front panel controls return to normal and you can play
the Pro 3 again.
6. Press the Global button again to exit the Global menu
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UPDATING THE OS FROM A MAC USING SYSEX LIBRARIAN
Before starting, close all other audio or MIDI or DAW software, and disconnect
all other MIDI devices. If necessary, download and install SysEx Librarian.
www.snoize.com/sysexlibrarian
To prepare the Pro 3 to receive system exclusive messages:

1. Press Global.
2. From the Global menu, select “MIDI Sysex Enable” and set it to “On.”
3. Next, select “MIDI Sysex Cable.”
4. If you’re using USB to update the OS, choose “USB.” If you’re using a
MIDI interface, choose “MIDI.”
5. Press Global again to exit the Global menu.
6. Connect your computer to the Pro 3 using either a USB cable or a MIDI
interface.
If using USB, the Pro 3 is a Class Compliant USB device. That means it does not
require any additional drivers to be installed to communicate with your computer.
It will appear in SysEx Librarian, the Mac’s Audio MIDI Utility, and other MIDI
applications as a MIDI port named “Pro 3.”
If using a MIDI interface, connect the computer’s MIDI out to the Pro 3’s MIDI
in. Depending on the type of interface, you may also need a MIDI cable.
Most MIDI interfaces or sound cards with built-in MIDI interfaces will work.
However, we have received reports that Digidesign/Avid interfaces and Native
Instruments Maschine may not transmit SysEx correctly for updates. The
M-Audio Uno is an inexpensive, reliable, and widely available MIDI interface
for use when updating our instruments.
IMPORTANT
There are two parts to the OS update — the Core OS and the Panel OS. Do not
attempt to send both of these at the same time or you may “brick” (disable) your
Pro 3. Instead, send the Core OS first, then, once it completes writing to the
synth, restart the Pro 3. Then send the Panel OS, and once it completes writing,
restart again.
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To load and update the OS:

1. Run SysEx Librarian.
2. Choose your MIDI interface from the “Destination” menu.
3. Click Add/+ to add the file to the file list or simply drag and drop the file on
the open SysEx Librarian window. The file name appears in the file list and
should be highlighted.
4. Click Play. The Pro 3 shows a numeric progress display indicating the
progress of the SysEx file’s transfer. Follow any directions listed on the
Pro 3’s screen before/after the countdown completes. When the file transfer completes, the “Do Not Turn Off!” is displayed as the OS is written to
memory. DO NOT power down while Pro 3 display shows this message.
When the installation completes, the Pro 3 restarts itself. You can verify the
install by pressing Global. The installed OS version appears in the display.
IMPORTANT
If the display goes dark when the update is sent to the Pro 3, do not shut
down the Pro 3. The Pro 3 will automatically power off then back on when the
OS update is complete. The update will take longer than the SysEx transmission
displayed in MIDI-OX.
TROUBLESHOOTING
If the numeric progress indicator stops before the file transfer is complete,
turn the Pro 3 off, then on, and try again. If this continues to happen, it may
be because the transmit speed is too high. Choose Preferences from the SysEx
Librarian menu. Click on “Transmit Speed” and reduce the speed. Then close the
Preferences window and try transmitting the file again. If the problem persists,
try reducing the speed more.
If “Status Byte Received In Data” is displayed, turn the Pro 3 off, then on.
This error means some other MIDI message the Pro 3 was not expecting was
sent through your MIDI interface. Make sure all other audio or MIDI or DAW
software is closed, and no other MIDI devices are connected. If you continue to
receive this message try restarting your computer and open SysEx Librarian as
your only application.
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RESETTING THE GLOBAL PARAMETERS
You must reset the Global parameters of the Pro 3 after you update the OS.
1. Press the Global button.
2. Press Soft Button 4 to choose the Commands tab
3. Use Soft Knob 1 to select Reset Globals, then press the Write button.
4. Press Soft Button 1 to confirm.
5. When finished, press the Global button again to exit the Global menu
CALIBRATING THE OSCILLATORS AND FILTERS
Please calibrate the oscillators and filters of the Pro 3 after you update the OS.
1. Press the Global button.
2. Press Soft Button 4 to choose the Commands tab
3. Use Soft Knob 1 to select Calibrate VCOs & Filters, then press the Write
button.
4. The synthesizer performs its auto-calibration procedure. Don’t turn off the
power while it’s doing this.
5. When finished, the front panel controls return to normal and you can play
the Pro 3 again.
6. Press the Global button again to exit the Global menu
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Patch Morphing
Patch Morphing allows you to smoothly transition in real time from one program to
another program using one of the Pro 3’s many controllers (touch slider, mod wheel,
etc). This gives you the power to “play” the morph in an expressive way and produce
sounds that are complex and often surprising.
Note that certain parameters cannot be morphed due to technical limitations:
Non-morphable parameters:
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•

All on/off parameters besides Osc 1 and Osc 2 sync are excluded from
morphing. These include Envelope Velocity, Grunge, State-Variable Filter
Bandpass on/off, Osc 3 Low Freq on/off, Paraphonic on/off, and so on.

•

All selectable parameters are excluded from morphing. These include LFO
shape selection, FX section, Filter type selection, Wavetable selection, Mod
Source and Destinations, and so on.

•

Sequencer parameters and Misc parameters are excluded from morphing.

•

Effect types. However, effect parameters can be morphed even if the morph
source and the morph target use different effect types. In other words, you
can have a delay on the morph source and a chorus on the morph target and
the values of the effects parameters will still morph.

•

Wavetables. While you can’t morph between different wavetables, the positions within the wavetable of the morph source and the morph target can be
morphed. The wavetable of the morph source will be applied to the morph
target.

•

Modulation routing setups.

•

Filter types. While you can’t morph between the 3 different filter types, the
cutoff, resonance, and drive settings can be morphed between morph source
and the morph target can be morphed. In other words, the Filter type of the
morph source will be applied to the morph target and the filter settings will
morph (the cutoff frequency, resonance, and drive settings).

Morph Source

Mode

Slider

All - Freq

MORPH SOURCE

MODE

U1 P1: Big Bad Lead

Key Modes

Morph Bank

Morph Prog

U2

P2

U2 P3: Chaotic

Glide

Pitch Wheel

Morph

The Morph Setup Controls

To use Patch Morphing:

1. Use the bank and program knobs to locate a sound you like. This will be
the morph source (the starting point for the morph).
2. Press the misc params button, then press Soft Button 4 to select the morph
tab
3. Use Soft Knob 1 to select a controller to perform the patch morphing (slider,
pressure, velocity, mod wheel, etc). By default this parameter is set to morph
off.
4. Use Soft Knobs 3 (morph bank) and 4 (morph prog) to select a program.
This will be the ending point of the morph or the morph target.
5. Use Soft Knob 2 to select the set of parameters that will be morphed. The
default setting is all-freq (all applicable parameters except oscillator
frequency).
Other morphable settings include:
•

all

- osc (all parameters except oscillator parameters)

•

all params

•

osc all

- freq (all oscillator parameters except frequency))

•

all env

(all envelope parameters)

•

mixer

•

and many others

(all parameters)

(mixer settings/parameters)
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6. Play the keyboard and manipulate the controller you’ve selected to control
morphing.
7. To save the program and the assigned morph settings, press write twice to
save the program in the current bank/program location. Alternatively, press
write once and use Soft Knobs 1 (bank) and 2 (program) to save to a new
location.
Editing a Morph Target
It’s useful to be able to edit a morph target (the program selected as the end point
of the morph) without leaving the morph setup controls. This allows you to optimize the target program for maximum effect. You can then save it.
To edit a morph target without leaving the morph setup controls:

1. Press the misc params button, then press Soft Button 4 to select the morph
tab.
2. Use Soft Knobs 3 (morph bank) and 4 (morph prog) to select a program.
This will be the ending point of the morph or the morph target
3. Press the front panel compare button.
4. Edit the Target program.
5. Press the front panel write button. This overwrites the target program.
6. Press the compare button to exit morph target program editing mode.
7. Play the keyboard and manipulate the controller you’ve selected to control
morphing.
8. To save the program and the assigned Morph settings, press write twice to
save the program in the current bank/program location. Alternatively, press
write once and use Soft Knobs 1 (bank) and 2 (program) to save to a new
location.
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Patch Morph NRPNs
The Patch Morphing feature adds severa newl NRPNs (non-registerd parameter
numbers) to the Pro 3 MIDI spec. Non-Registered Parameter Number (NRPN)
MIDI messages are used to transmit and receive both global and program
parameters. They are transmitted when MIDI Parameter Send is set to NRPN in
globals, and received when MIDI Parameter Receive is set to NRPN in globals.
•

304 - Morph Source

•

305 - Morph Target Bank

•

306 - Morph Target Program

•

307 - Morph Target Mode

•

308 - Morph Amount
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